Using SurfaceReader

SurfaceReader is designed to provide speech output to assist visually-impaired
users in their use of music and audio applications when used in conjunction with
a screen-reader and a hardware control surface. It is a significant rewrite of its
predecessor, the Mackie Display Reader, and provides the following features:

Speech feedback triggered by any button, knob or fader on your
control surface that transmits a MIDI message.

Speech feedback of any control surface text display that is controlled
by an application-generated MIDI message.

Speech feedback for any control surface LED lamp that is controlled
by an application-generated MIDI message.

User-definable control surface protocols, allowing you to define the
MIDI messages for your favourite device if a configuration file is not
already supplied.

User-definable application configurations, allowing you to define
what feedback you hear for each button, knob and fader on your
control surface.

Support for multiple different active control surfaces, even if they’re
controlling different applications.

Multiple modes of operation, allowing you to extend the available
functions of your control surface beyond what its manufacturer
provides.

Support for operation under Windows and Mac operating systems.

Any protocol definitions and/or application configurations that you
create can be shared with other users.



System Requirements

SurfaceReader can be run on any of the operating systems detailed in the
following topics



System Requirements - Limitations

SurfaceReader has been designed to work with as many hardware devices and
software applications as possible by using MIDI messages as a means of
obtaining information about what’s happening in your software. However, we
are aware of the following limitations:

Although SurfaceReader should allow you to get an increased level of
accessibility when used with any software that supports your control
surface, it cannot help with applications that do not offer such support

You may require sighted help to install and configure your software
for use with SurfaceReader. For example, the dialog box for setting
up control surfaces within Cubase is not at all friendly with Jaws.

SurfaceReader does not currently offer support for the Novation
range of control surfaces and controller keyboards. These devices use
their own AutoMap software to handle their MIDI communications.
We hope to address this limitation in a future release, but can make no
promises.

We have tried to maximise the flexibility of SurfaceReader by
allowing a considerable amount of programmability within Screen-
Reader mode. However, the differences between the various screen-
reading packages makes it impossible to provide a completely
consistent approach. Indeed, no programmability is possible using
System Access or NVDA, though there is the possibility of providing
such support in future versions if these products implement the
required functionality.



System Requirements - Windows

SurfaceReader can be run on any of the following Windows variants:
e Windows XP, 32-bit.

Windows Vista, 32-bit.

Windows Vista, 64-bit.

Windows 7, 32-bit.

Windows 7, 64-bit.

Windows speech.

Speech output can be provided on the supported Windows platforms using any
of the following screen-readers:

e Jaws. Version 8 is the minimum requirement for SurfaceReader
operation, though later versions may be required to suit your installed
flavour of Windows.

e Window-Eyes. Version 7.0 is the minimum requirement for operation
with SurfaceReader.

e Dolphin Supernova ScreenReader. Version 11.53 is the minimum
version required for SurfaceReader operation.  Unfortunately,
Supernova operation is only currently available for 32-bit versions of
Windows.

e System Access. Any version of System Access should provide basic
speech output on either 32 or 64-bit versions of Windows.

e NVDA. [Which Tim burgess still has to comment on here]

Additional MIDI software

In order to provide SurfaceReader’s advanced features it is necessary to install
two virtual MIDI cables for each physical control surface that you wish to use.
Windows does not provide virtual MIDI cabling natively, so you will need to
obtain suitable software to provide the required support. The following
packages have been tested with SurfaceReader:

MIDI-Yoke.



This can be downloaded for free from http:/www.midiox.com and is
recommended for use under Windows XP. We have encountered reports that this
package also works under Windows Vista and Windows 7, but these later
versions of Windows are not officially supported by MIDI-Yoke’s authors and so
any experimentation with such a combination will be at your own risk.

LoopBe30.

This is available at a very modest price from
http://www.nerds.de/en/loopbe30.html and supports Windows XP, Windows
Vista and Windows 7 (both 32-bit and 64-bit versions). Please note that its free
companion program, LoopBel, is not suitable for use with SurfaceReader, as it
provides only one virtual cable.


http://www.midiox.com

System Requirements - Apple Mac

SurfaceReader is able to run under Mac OSX 10.6, Snow Leopard, and later. No
additional software is required to set up virtual MIDI cables, as this capability is
already built-in on the Mac operating system. The virtual cables can be set up
using the Audio/MIDI Setup app located in the /applications/utilities folder,
though this will require sighted assistance as the required panel is inaccessible
using VoiceOver.



Basic Configuration

SurfaceReader can support multiple control surfaces, even if they're using
different control surface protocols. Your installed surfaces are shown in the
Surfaces list, which is displayed in the main window of the application when you
first run it. The Surface menu is used to perform all actions that relate to a single
surface so, apart from when you want to add a new control surface, you will
need to select the surface you want to configure in the Surface list before using
any of the Surface menu options.



Installation

Please download the appropriate installation program for your operating system
from http://www.raisedbar.net and save it on your local hard disk (do not attempt
to run the installation program from the web page). All you need to do then is
run the downloaded file.



http://www.raisedbar.net/

A worked example for SurfaceReader configuration.

Dealing with virtual MIDI routing can be confusing and has generated a lot of
support email traffic, so a worked example of how to configure a typical setup is
provided here to try and clarify things. The following instructions should help
get SurfaceReader going with a Behringer BCF2000, the LoopMIDI virtual
MIDI package and Sonar. The same principles should apply for any other control
surface, virtual MIDI package and any other DAW application:

LoopMIDI configuration.

1.
2.

Download LoopMIDI from The LLoopMIDI page.

Install LoopMIDI. The installation doesn't prompt for a reboot, butl think
it's probably a good idea.

Once installed, open the LoopMIDI item that should now be on your
Desktop.

You should now be in the Setup panel, so Tab to the "New port-name" entry
and edit it to say "LoopMIDI 1" (without the quotes).

5. Tab to the Plus button and press Enter.

6. Tab to the "New port-name" entry again and edit it to say "LoopMIDI 2"

(without the quotes).

7. Tab to the Plus button and press Enter.
8. Press Alt+F4 to close the LoopMIDI interface. Again, I'd reboot for safety's

10.

11.

sake.

Once you've rebooted, go to the System Tray (Insert+F11 for Jaws users)
and select LoopMIDI. Arrow down to the option to Start Minimized and
press Enter - this will stop the interface from getting in the way in the
future.

Go to the System Tray again and select LoopMIDI. Arrow down to the
option to Autostart LoopMIDI and press Enter - this will make sure that the
ports that you've set up will be available every time you boot your machine
without you having to manually run LoopMIDI from the Desktop.

Reboot again.


http://www.tobias-erichsen.de/software/loopmidi.html

A worked example for SurfaceReader configuration.

Configuring SurfaceReader with LoopMIDI

1. Load SurfaceReader.

2. Choose Add from the Surfaces menu to add a new control surface.

3. Give your surface a name and pick a protocol from the list. For the

purposes of this example I'll call the surface BCF2k and choose the Mackie
Control protocol.

Press Enter on the Setup MIDI Hardware button.

5. In the dialog that appears, choose the input port that your control surface is

physically connected to (e.g. BCF2000 port 1 for a Behringer BCF2000
connected by USB).

Tab to the output list and choose the virtual port that will send data to your
DAW software. In this example we'll use LoopMIDI 1. Tab to the OK
button and press Enter.

7. Tab to the Setup MIDI Display button and press Enter.

8. In the dialog that appears, choose the virtual input port that will receive

10.

display data from your DAW software. In this example it'll be LoopMIDI 2.

Tab to the output list and choose the physical port that will send data back
to your actual control surface (e.g. BCF 2000 Port 1 for our Behringer unit).
Tab to the OK button and press Enter.

Tab to the Finish button and press Enter and your new surface definition
should be added to the list.



A worked example for SurfaceReader configuration.

Configuring Sonar.

e Load Sonar.
¢ Go to the Options menu and choose MIDI Devices.

* Make sure that your new virtual ports are configured correctly in the input and
output lists and that the physical ports being used by your control surface are
unchecked. In this example, the setup should be:

Input list.

¢ LoopMIDI 1 checked.
e LoopMIDI 2 unchecked.
e BCF2000 Port 1 unchecked.

Output list.

e LoopMIDI 1 unchecked.
¢ LoopMIDI 2 checked.
e BCF2000 Port 1 unchecked.
e Go to the Options menu and choose Control Surfaces.

* Add a new Mackie Control definition with its input port set to LoopMIDI 1
and its output set to LoopMIDI 2.



Changing the active protocol.

To change the protocol that your control surface is using:

1. Change the active protocol or memory preset on your control surface
hardware using the manufacturer's instructions.

Select the surface in the Surface list that you want to change.
Go to the Surface menu.

Select the Properties sub-menu.

Select Protocol.

Pick the protocol definition that you want to use from the list.
Tab to the OK button and press Enter.
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Protocol Definitions

If you own a control surface and SurfaceReader doesn't already provide a
protocol definition for it, don't despair. SurfaceReader allows you to define the
MIDI messages that your device uses to create new protocol definitions. These
definition files can be shared with other users.



What is a Protocol

A control surface protocol is just a set of MIDI messages that a manufacturer has
decided to use to handle communication between the control surface itself and
any application program that it is trying to control

You can think of control surfaces as being in one of two categories:
1. One-way devices.

2. Two-way devices.

One-way devices.

These tend to be the cheaper kind of control surfaces, very often implemented as
keyboard or drum pad controllers. Their knobs, faders and buttons transmit
MIDI messages that the application receives and processes, but there is no MIDI
traffic being fed back to the device to supply state information. For this reason,
they tend to offer on-board presets that change what messages each of the knobs,
faders or buttons transmit - this allows them to cope with differing application
program requirements.

Examples of one-way controllers would be any of the M-Audio keyboard
controllers and the Kenton Control Freak.

Two-way devices.

These devices also transmit MIDI when their hardware controls are adjusted, but
they also receive MIDI messages back from the software that they're controlling.
This extra information is used to change display elements on the control surface,
such as LED lamps and text displays, allowing the user to more easily
understand and change the behaviour of the application software being
controlled. The important thing to realise about the contents of any displays
populated in this way is that the information being shown is completely
generated by the application program and, specifically, its control surface driver.

Examples of two-way control surfaces are the Mackie Control Universal, the
Mackie C4 and the Logic Control.

SurfaceReader and control protocols.

SurfaceReader allows you to teach it the MIDI messages that your control



surface uses and save them as a protocol definition. This means that you can use
any number of devices that use these protocols and allow others to take
advantage of your definitions by sharing the configuration files



Creating a new protocol.

To create a new protocol definition, bring up the Protocol Wizard as follows:
1. Go to the File menu.
2. Select the New sub-menu.
3. Select Protocol definition...

The Protocol Wizard will appear, with the Surface page in focus. Each of the
wizard's pages are described in the topics that follow.



Surface Page

The Surface page presents the same options as for the Surface menu's Add...
dialog box, except for there being no protocol list box. You are not allowed to
create a new protocol without defining a surface that will use it. Once you've
provided the required settings, Tab to the Next button and press Enter.



System Exclusive Page

This page allows you to define a name for your new protocol, together with any
byte values that your device uses to identify its MIDI system exclusive
messages. The fields are as follows:

¢ Protocol name.

Manufacturer ID byte 1.

Manufacturer ID byte 2.

Manufacturer ID byte 3.
Model ID.
Device ID.

Apart from the protocol name, all of the other fields require a single byte value
in hex format, so the valid range is from 00 to FF. The rule for the manufacturer
ID is that, if the first byte is 00, the remaining two bytes must be specified. If the
first byte is other than 00, the remaining two bytes should be empty.

The model and device ID values can be left blank if your device documentation
doesn't specify values.

Once you've completed this page, press Tab until you get to the Next button then
press Enter.



Text Displays Page

The Text Displays page of the Protocol Wizard contains a list box which shows
an entry for each defined display and a number of buttons, as follows:

e Add. This button takes you into another dialog where you can define a
display to add to the list box.

e Rename. This button prompts you for a new name for the display that is
currently selected in the list box. This button will be unavailable if no
display is selected.

e Translation tables. This button brings up a dialog box that allows you to
define the character set for the display that is selected in the list box. You
only need to define a translation table if your display uses a character set
encoding that differs from ASCII. This button will be unavailable if no
display is selected in the list box.

e Delete. Pressing this button will prompt you to confirm removal of the
selected display from the list box. This button will be unavailable if no
display is currently selected.

Once you have defined the displays on your unit, Tab to the Next button and
press Enter.



Adding a Text Display

The Text Display Definition dialog box contains the following entries:

Display name - this is just a descriptive name for your display. It can help
later if you use the same name(s) as those used in the device manufacturer's
documentation.

Number of display lines - this is self-explanatory and defines the number of
lines that the display extends over.

Display length - it is important to realise that this is not the same as the
length of a single line of the display, but represents the total length of the
display. For example, the Frontier Designs Tranzport surface has an LCD
display that has two lines of 20 characters each, making the display length
equal to 40.

Strip columns - this entry allows you to define the number of channel strips
that your surface represents. Again, the Tranzport only displays a single
track or bus at a time, so you'd enter 1 here. In comparison, the Mackie
Control Universal is organised more like an eight-channel mixer, with eight
channel strips, so the correct entry would be 8.

MIDI message definition... button. This button allows you to specify the
MIDI message that sends text to this display.

Once you've entered values into all of the fields and defined a MIDI message,
Tab to the OK button and press Enter to return to the Text Displays page - your
newly-defined display should now appear in the list box.



Translation Tables.

The Translation Tables dialog contains the following items:

e A list box of defined translation tables.
e The Add translation table... button.
e The Edit translation table... button.

e The Delete translation table... button.

Adding a translation table.

To add a new translation table:

1.
2.

Tab to the Add translation table... button and press Enter.

You will be prompted to give your translation table a name, so type one in
then Tab to the OK button and press Enter.

A new dialog box will appear containing the following items:
o A list box containing default values for each supported character code.
o The Edit character... button.

Select the character you want to redefine in the list then Tab to the Edit
character... button and press Enter.

You will be prompted to enter a new description for this character value.
You could type in an individual alphanumeric or punctuation symbol, or a
descriptive phrase. Tab to the OK button and press Enter when you're done.

Once you've defined all of the characters that you want to change from their
default values, Tab to the OK button and press Enter. You will be returned
to the Translation Tables dialog box and your new table should have
appeared in the list box.

Editing a translation table.

To edit an existing translation table:

1.
2.
3.

Select the table you want to edit in the list box.
Tab to the Edit translation table... button and press Enter.

A new dialog box will appear containing the following items:



o A list box containing the defined values for each supported character
code.

o The Edit character... button.

4. Select the character you want to redefine in the list then Tab to the Edit
character... button and press Enter.

5. You will be prompted to enter a new description for this character value.
You could type in an individual alphanumeric or punctuation symbol, or a
descriptive phrase. Tab to the OK button and press Enter when you're done.

6. Once you've defined all of the characters that you want to change from their
default values, Tab to the OK button and press Enter. You will be returned
to the Translation Tables dialog box.

Deleting a translation table.
To delete a translation table:
1. Select the table you want to remove in the list box.
2. Tab to the Delete translation table... button and press Enter.

3. You will be prompted to confirm the removal of the table. If you answer
"Yes", the table will be removed from the list box.



LED Lamps Page

The LED Lamps page of the Protocol Wizard contains a list box which shows an
entry for each defined LED and a number of buttons, as follows:

e Add. This button takes you into another dialog where you can define a LED
lamp to add to the list box.

e Define LED states. This button takes you into another dialog that allows
you to define names for the possible states of the selected LED in the list
box. for example, On, Off or Flashing. This button will be unavailable if no
LED is selected.

e Rename. This button prompts you for a new name for the LED that is
currently selected in the list box. This button will be unavailable if no LED
is selected.

e Delete. Pressing this button will prompt you to confirm removal of the
selected LED from the list box. This button will be unavailable if no LED is
currently selected.

Once you have defined the LED lamps on your unit, Tab to the Next button and
press Enter.



Adding a LED Lamp

The Define LED Lamp dialog contains the following items:

e LED lamp name - this is just a descriptive name for the lamp. It is useful to
use the same names as those in the manufacturer's documentation.

e The MIDI message definition... button. If you press Enter on this button
you can define the MIDI message that your application software sends to
your control surface in order to change the state of this LED.

Once you've provided a name and a message definition for your LED lamp, you
can Tab to the OK button and press Enter. Your new LED lamp should then
appear in the list box.



LED States
To define LED states:
1. Select the LED you want to define states for in the list box.
2. Tab to the Define LED States... button and press Enter.
3. A new dialog box will appear containing the following items:
A list box of defined states.
The Add State... button.
The Edit State... button.
The Delete State... button.
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4. Perform your desired operations until the contents of the list box are what
you want, then Tab to the OK button and press Enter.

Adding a state.

If you press the Add State... button described above, you will be prompted to
define a new state by providing the following information:

e A descriptive label for the state (e.g. on, off or flashing).

e The MIDI data value that makes the LED go into the described state. Please
note that this value needs to be supplied as a hexadecimal value between 00

and ff.

Once you've provided this information, Tab to the OK button and press Enter
and your new entry should appear in the Defined States list box.

Editing a state.

To edit a lamp state:
1. Select the state you want to edit in the Defined States list box.
2. Tab to the Edit States... button and press Enter.

3. You will be prompted for a label and value, just as when you defined the
state originally, but the edit boxes will contain the currently-defined values,
so edit them to reflect the desired change.

4. Once you've finished your editing, Tab to the OK button and press Enter.



Your updated entry should appear in the Defined States list box.

Deleting a state.

To delete a state:
1. Select the state you want to delete in the Defined States list box.
2. Tab to the Delete States... button and press Enter.

3. Confirm the deletion.



Hardware Controls Page

The Hardware Controls page of the Protocol Wizard contains a list box which
shows an entry for each defined control and a number of buttons, as follows:

e Add. This button takes you into another dialog where you can manually
define a control to add to the list box.

e Learn. If you press this button after adjusting one of your surface's
hardware controls SurfaceReader will attempt to analyse the MIDI message
that the control transmitted and automatically create a definition for that
control. You will be prompted to enter a unique name for the control if the
analysis is successful. Using this method is much easier than using the
Add... button, which is only provided for special cases.

e Rename. This button prompts you for a new name for the control that is
currently selected in the list box. This button will be unavailable if no
control is selected.

e Delete. Pressing this button will prompt you to confirm removal of the
selected control from the list box. This button will be unavailable if no
control is currently selected.

Once you have defined the controls on your unit, Tab to the Finish button and
press Enter to complete your protocol definition.



Adding a Hardware Control Manually

If you experience problems using the Learn... button to train your hardware
controls, use the following method to define them manually:

1. Tab to the Add... button and press Enter.

2. Type in a descriptive label for your control.

3.

4. Define the MIDI message for your control using the dialog box that

Tab to the MIDI message... button and press Enter.

appears.

Tab to the OK button and press Enter. Your new control definition should
appear in the list box.



Editing a protocol.

To edit an existing protocol definition, bring up the Protocol Wizard in edit
mode, as follows:

1. Select the surface in the Surface list that you want to change.
2. Go to the Edit menu.
3. Select Protocol.

The Protocol Wizard will appear, with the System Exclusive page in focus.
There is no Surface page in this version of the Protocol Wizard, as you've
already defined the required parameters for that part of the process. The
remaining pages are the same as when you run the Protocol Wizard for a brand
new definition:

1. The System Exclusive page.
2. The Text Displays page.

3. The LED Lamps page.

4. The Hardware Controls page.



Application Configurations

An application configuration allows SurfaceReader to be configured differently,
depending on what audio/music application program you're working with.



What is an application configuration?

The nature of control surfaces means that the functions that their various buttons,
faders and knobs perform change from one application to another, so
SurfaceReader allows you to create application configurations that make sure
that the feedback that you get is appropriate for the application you're working
with. An application configuration can assign custom names to any or all of your
surface's controls and let you define lists of actions that each control will
perform when activated.



Creating a new application configuration.

To create a new application configuration, bring up the Configuration Wizard as
follows:

1.

A L

Select the surface you want to configure from the Surfaces list.
Go to the File menu.

Select the New sub-menu.

Select Application Configuration...

Type in the name of the application you want to configure, then Tab to the
OK button and press Enter.

If the application that you've chosen already has a configuration, you'll be
queried as to whether you want to overwrite it.

The Configuration Wizard will appear, with the focus set on the active protocol
name. There are a number of buttons that will show up as you Tab through the
dialog, depending on your current location within the Configuration tree.

e Rename. This button allows you to change the name of the selected control.

The new name will only be used when this application configuration is
loaded - the default label that is defined within the protocol definition will
be used everywhere else. This button will only be available when you are
focused on a control name.

Add. This button brings up another dialog that allows you to pick an action
to add to the selected control. You can add as many actions to a control as
your computer's memory and hard drive space allows, so it is possible to
create some very complex setups. This button will only be available when
you're focused on one of the available modes for your selected control and
active screen reader - you are only allowed to add or modify actions in the
branches of the tree that relate to the active screen reader on your system.

Delete. This button allows you to remove actions you've added previously.
The Delete button is available at the same times as the Add button.

Up and Down buttons. If you've added some actions, but want to change the
order in which they're executed, use these buttons. The Up and Down
buttons are only available when you're focused on an action.



Renaming Controls

To rename a control within the Application Configuration wizard:

1.
2.
3.

Select a control name within the tree view.
Tab to the Rename button and press Enter.

A dialog box will appear prompting you for a new control name. Type the
new name in the edit box, press Tab to get to the OK button and press Enter.

The wizard will check that the new name is unique and warn you if it is not,
so that you can try again. If your new name is unique, you'll be returned to
the tree view, focused on the selected control and its new name.



Adding Actions

To add an action to a control within the Application Configuration wizard:

1.
2.

Select the control you want to add the action to.

Expand the tree by pressing the right arrow key until you get to the level
which shows the supported screen readers.

Use your up and down arrow keys to select the screen reader that you are
currently using (you will not be allowed to add actions relating to any other
screen reader).

Expand the screen reader branch by pressing right arrow - this will take you
to the level where you can choose which surface mode you want the new
action to be active.

Use your up and down arrow keys to pick the mode you want to use (either
Live or Screen Reader).

Tab to the Add button and press Enter.

7. The Action Picker dialog will appear where you can define your new

action.

When you've defined your new action, you'll be placed back in the tree
view of defined controls and actions.



Using the Action Picker dialog.

1. When you first activate the Action Picker dialog box, you'll be focused on
the control name you're defining the action for. Press the right arrow key to
expand the tree view and place yourself at the level where you can pick one
of the available action types.

2. Use your up and down arrow keys to pick from the available acteion types.

3. Once you've selected the action that you want to add, press Tab. If this takes
you to the OK button you can just press Enter to add your new action to the
selected control. If you find yourself on a Properties button instead, press
Enter to define the additional information that your selected action requires.

4. Once you've defined any action properties you'll be returned to the Action
Picker dialog, so just press Tab to get to the OK button and press Enter to

finish defining your action.
Available actions.

The following actions are available:
Action Meaning

Do nothing No action is performed. This can be very handy if you want to make sure that you get no
spoken feedback from a control (for example, the Record button, so you don't accidentally
record the speech as the recording starts).

Say Control Announces the name you've defined for this control
Label

Say Control Announces the value of the control (for example, on, off or the MIDI value that it is
State generating.

Say Control A combination of the previous two actions.

Label and

State

Read Reads the entire contents of the specified display, or its state if it is an LED lamp.

Display

Read Reads the specified line of the specified display. Does nothing for LED lamps.

Display Line

Read Reads the specified column information within the specified display. For example, reading
Display strip 1 of the LCD display on a Mackie Control Universal would announce the two-column
Strip block of text immediately above the first V-Pot.

Read Allows you to read any part of a specified display by allowing you to specify a starting
Display position and a number of characters to be read from that position.

Section



Press Key  Equivalent to pressing the specified key combination on your QWERTY keyboard. This
Combination feature will not be implemented until version 1.1.

Change Allows you to cycle through the available modes for your surface by just pressing a button
Surface on that surface.

Mode

Run Hot This option is currently only available to Jaws users who have HotSpotClicker installed. You
Spot can pick a hot spot to be executed from a defined HotSpotClicker file.

Run Screen This action is currently only available to Jaws and Window-Eyes users. You can pick a script
Reader or function to be exected whenever you activate the selected control.

Function

MIDI Info  This action allows you to hear the MIDI message information generated when you adjust a
control surface button, knob, or other control. This is only allowed for those protocols that
are not copy-protected. If you add a MIDI Info action to an encrypted protocol then the
control's label will be read instead

Defining action properties.

Depending on which action type you select from the Action Picker dialog, you
may need to specify additional information by pressing the Properties button.
You will then be shown another dialog that will allow you to select the required
additional content. For example, if you choose to add a Read Display Line
action, the Properties button will prompt you for the name of the display to be
read and allow you to Tab to a list of valid line numbers for that display, so you
can't get it wrong.



Editing an application configuration.

To edit an existing application configuration:

1.

5.
6.

Select the surface you want to configure from the Surfaces list.

2. Bring up the Surfaces menu.
3.
4. Select the configuration that you want to edit from the list box then Tab to

Select the option: Load application configuration...

the OK button and press Enter.
Bring up the Edit menu.

Select the option: Application configuration...

The Configuration Wizard will appear with the active protocol name as the
focused tree item. For more information on editing application configurations,
see the topic: Creating a new application configuration.



Appendix

Topics not contained in the main Help will usually be found here.



Defining a MIDI Message

To define a MIDI message using the Define MIDI Message dialog box:

1. Choose the required message type from the group of radio buttons. The
hexadecimal values shown in parenthesis after the message type represent
the MIDI value for this message type and is shown to help you identify the
correct values in the equipment manufacturer's documentation.

2. Fill in any additional fields that may appear to help you complete the
message definition. The possible fields are described below.

3. Tab to the OK button and press Enter.

MIDI message fields.

The following descriptions should help you understand any additional prompts
that may appear after you've selected a message type.

MIDI channel.

If you selected a message type of Note on, Note on/off, CC, Pitch Wheel, RPN,
NRPN, or Nibble by nibble, You need to enter which MIDI channel your
message will be transmitted on when the desired control is adjusted. The valid
values, in decimal form, are 1 through 16 inclusive.

Note number.

This is a decimal number representing a specific note in MIDI. Most control
surfaces transmit note on or note on/note off messages, with the note number
indicating which particular button was pressed/released. Your control surface
documentation should contain a table of button names and their corresponding
note number values. Many surfaces also use this kind of message to change the
state of LED lamps and, again, the manufacturer's documentation should provide
the values.

Message number

If you've selected a message type of CC, RPN or NRPN, this field will appear.
The number you need to enter will be provided by your control surface's
documentation and should be entered in decimal format.



System exclusive message, Add Address byte... and Remove Address Byte....

If you selected a message type of Complete SysEx, you will be able to create a
MIDI system exclusive message definition. These messages are constructed
using the information from the System Exclusive page of the Protocol Wizard,
together with a number of command address bytes that you define here. The
following items will appear in your Tab order:

1. The System exclusive message read-only edit box. This contains a
representation of a MIDI system exclusive message that you've defined for
this control. it is displayed to help you check your message definition as
you add/remove bytes to/from the message.

2. The Add message address byte... button. If you press Enter on this button
you will be prompted to type in a byte value in hexadecimal format (the
valid range is 00 through ff, inclusive). Once you've typed in the value,
press Tab to get to the OK button then press Enter. Your new byte will
appear within the System exclusive message read-only field, so you can
check that its value and position are correct. Please note that address bytes
are added immediately before the terminating F7 (end of system exclusive
message) byte.

3. Remove message address byte button. If you press Enter on this button you
will successively remove any address bytes that you've added to the
message definition. Bytes are removed in reverse order, so the last byte you
added will be the first to be removed. You can check the System exclusive
message read-only edit box to ensure that you know what's happening.



Keyboard Shortcuts

Surface List.

The following keystrokes are defined when you are focused on the Surface list.

Keystroke Function

Delete Removes the selected surface.

F1 Displays the Help system's Table of Contents.

F2 Renames the selected surface.

F3 Puts the selected surface into Live mode.

F4 Puts the selected surface into ID mode.

F5 Puts the selected surface into Screen reader mode.

Alt+Enter Edits the selected surface's protocol (same as choosing Surfaces>Properties>Protocol from

the menu system).

Control+Enter Shows a report detailing the current state of all of the displays defined for the selected
surface.



Using a Frontier Designs Tranzport

Sonar

Panel Layout

LCD display

Battery Backlight

Prev Track Next Track Arm Mute Solo Undo — (above  jog
wheel)

In Out Punch Loop

Shift (large circular Prev Add Next

button)

Rewind FF Stop (WIthPlay Record

tactile dot)

TranzPort Button and Data Wheel Functions

Many of the buttons on the Tranzport can be used with either the Shift or Stop
buttons to provide extra functions:

Button name Normal Function Shift +Function Stop button +Function
Rewind Rewind Return to zero
Fast Forward Fast forward Go to end
STOP Stop Toggle ~ Big  Meter Modifier key
mode
Audio  Scrubbing:
PLAY Play Toggle playback Hold and use wheel

metronome on/off i
to scrub audio

Toggle record



RECORD

PREV

ADD

NEXT

IN

ouT

PUNCH

LOOP

Previous
TRACK

Next TRACK

REC

MUTE

SOLO

Record metronome on/off

Go to previous .
marker - Hold tOUser—deflned % Curl+Shift+F1

scroll with wheel Shift+F1

Add marker atUsgr—defmed as Ctrl+Shift+F?2
current location Shift+F2
Go to next marker - .
Hold to scroll WithUser—deﬁned aSCtrl+Shift+FS

wheel Shift+F3

Set punch in point  Set loop in point Ctrl+Shift+F4
Set punch out point Set loop out point  Ctrl+Shift+F5

Toggle punch modeCycle through time

(LED inactive) formats Crl+Shift+F6

Toggle level/pan
Toggle loop mode selection for shifted Ctrl+Shift+F7
data wheel changes

Previous track/bus
(left/down) - hold to Show tracks Ctrl+Shift+8
scroll with wheel

Next track/bus

(right/up) - Hold toShow buses Ctrl+Shift+9
scroll with wheel

Toggle track’sClear all  record

. Ctrl+Shift+F10
record arm on/off  arming

Toggle track’s mute

Clear all mutes Ctrl+Shift+F11
on/off

Toggle track’s solo

Clear all solos Ctrl+Shift+F12
on/off



UNDO Undo last action Redo last undo
DATA WHEEL Scroll timeline Adjust level or pan

FOOTSWITCH User Definable



Sonar

Panel Layout

LCD display

Battery Backlight

Prev Track Next Track Arm

In Out Punch
Shift (large circular Prev Add
button)

Rewind FF Stop

tactile dot)

TranzPort Button and Data Wheel Functions

Mute Solo Undo  (above  jog
wheel)
Loop
Next
(with

Play Record

Many of the buttons on the Tranzport can be used with either the Shift or Stop

buttons to provide extra functions:

Button name Normal Function

Rewind Rewind

Fast Forward Fast forward

STOP Stop
PLAY Play
RECORD Record
Go to previous

Shift +Function Stop button +Function

Return to zero

Go to end

Toggle Big Meter Modifier key

mode

Toggle playback Audio  Scrubbing:

Hold and use wheel

metronome on/off i
to scrub audio

Toggle record
metronome on/off



PREV

ADD

NEXT

IN

ouT

PUNCH

LOOP

Previous
TRACK

Next TRACK

REC

MUTE

SOLO

UNDO

marker - Hold toUser-defined as Ctrl+Shift+F1
scroll with wheel Shift+F1

Add marker atUsgr—defmed as Ctrl+Shift+F?2
current location Shift+F2
Go to next marker - .
Hold to scroll WithUser—deﬁned aSCtrl+Shift+FS

wheel Shift+F3

Set punch in point  Set loop in point Ctrl+Shift+F4
Set punch out point Set loop out point  Ctrl+Shift+F5

Toggle punch modeCycle through time

(LED inactive) formats Ctrl+Shift+F6

Toggle level/pan
Toggle loop mode selection for shifted Ctrl+Shift+F7
data wheel changes

Previous track/bus
(left/down) - hold to Show tracks Ctrl+Shift+8
scroll with wheel

Next track/bus

(right/up) - Hold toShow buses Ctrl+Shift+9
scroll with wheel

Toggle track’sClear all  record Ctrl+Shift+F10

record arm on/off  arming

Toggle track’s mute Clear all mutes Ctrl+Shift+F11

on/off

Toggle track’s solo Clear all solos Ctrl+Shift+F12
on/off

Undo last action Redo last undo

DATA WHEEL Scroll timeline Adjust level or pan



FOOTSWITCH User Definable



Panel Layout

LCD display

Battery Backlight

Prev Track Next Track Arm

In Out Punch
Shift (large circular Prev Add
button)

Rewind FF Stop

tactile dot)

TranzPort Button and Data Wheel Functions

Mute Solo Undo  (above  jog
wheel)
Loop
Next
(with

Play Record

Many of the buttons on the Tranzport can be used with either the Shift or Stop

buttons to provide extra functions:

Button name Normal Function

Rewind Rewind

Fast Forward Fast forward

STOP Stop
PLAY Play
RECORD Record
Go to previous
PREV marker - Hold to

scroll with wheel

Shift +Function Stop button +Function

Return to zero

Go to end

Toggle Big Meter Modifier key

mode

Toggle playback Audio  Scrubbing:

Hold and use wheel

metronome on/off i
to scrub audio

Toggle record
metronome on/off

User-defined

as .
Shift+F1 Ctrl+Shift+F1



ADD Add marker at Usgr—defined aS ~ 14 Shift+F?
current location Shift+F2
Go to next marker " User-defined as
NEXT Hold to scroll with_, . Ctrl+Shift+F3
Shift+F3
wheel
IN Set punch in point  Set loop in point Ctrl+Shift+F4
ouT Set punch out point Set loop out point  Ctrl+Shift+F5
PUNCH Toggle; pur}ch mode Cycle through time Ctrl+Shift-T6
(LED inactive) formats
Toggle level/pan
LOOP Toggle loop mode selection for shifted Ctrl+Shift+F7
data wheel changes
Previous Previous track/bus
(left/down) - hold to Show tracks Ctrl+Shift+8
TRACK .
scroll with wheel
Next track/bus
Next TRACK (right/up) - Hold toShow buses Ctrl+Shift+9
scroll with wheel
REC Toggle track sCle::}r all  record Ctrl+Shift+F10
record arm on/off  arming
MUTE Toggle track’s mute Clear all mutes Ctrl+Shift+F11
on/off
SOLO Toggle track’s solo Clear all solos Ctrl+Shift+F12
on/off
UNDO Undo last action Redo last undo
DATA WHEEL Scroll timeline Adjust level or pan

FOOTSWITCH User Definable
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